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Managing Your Call Log 

The Call Log details all incoming, outgoing, and missed calls and also provides a summary of total calls. The Call Log  can also 
tell you when a call was initiated, how long it lasted, and provides easy access to any notes taken during the call. 

 

 

Viewing details of calls 

Tap in the top-left corner of the screen and then select a category from the drop-down menu.  

Calls are categorized as below: 

 

?? All Calls - shows all calls made to and from the phone in chronological order.  

??   Missed - shows calls that were not answered.  

??   Outgoing  - only shows calls made from the phone.  

??   Incoming  - only shows calls made to the phone.  

?? By Caller - categorizes calls alphabetically according to caller name.  

To view duration of call 

 

?? Go to Call Log, find the call you are interested in, and then 
tap it once. 

Time of call 

Tap here to select All Calls, Missed, 
Outgoing, Incoming or By Caller 
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To delete individual calls from Call Log 

?? Press and hold the center of the navigation pad, and then select Delete from the pop-up menu. 

To delete all calls from Call Log 

?? Tap Tools, and then Delete all Calls. 

To set limits on the size of your Call Log 

  

?? Tap Call Log, Tools, Options and then the box under Delete call log items 
older than. 

?? In the drop-down menu choose a period of time and then tap OK. 

Customizing Your Phone 
You can personalize the setting of your phone, the services you have and the network you are connected to. 
 

To select ring type and tone, and keypad sounds 
 1. In phone dialer, tap Tools, Options  and then Phone.  

2. Tap to see the drop-down menu choices below. 
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Downloading Ring Tones 
You can make a connection to the Internet and then download ring tones that are compatible with the .WAV format. 

To enable the PIN 
1. In phone dialer, tap Tools, Options  and then Phone.  

 
2. Under Security, tap the option Require PIN when phone is used. 

To change the PIN 
 

 

 
1. Under Security, tap Change PIN. 
 
2. Follow the instructions - enter the old pin, then a new one, and re-enter for 

confirmation.  

To enable Caller ID 
  

When you place a call, your phone number will be revealed to the person that you are 
calling. To disable this function: 

1. In phone dialer, tap Tools, Options  and then Services .  

2. In Services , tap Caller ID, and then Get Settings (retrieving settings may take a 
few minutes).    
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3. In the next  screen, tick either Everyone I call (Enable) or Never provide caller 
ID (Disable) and then OK.  

 

 

Call Forwarding  

This service allows you to forward your incoming calls to another phone number. You can choose to forward all calls to the same 
number or specify a number based on the following conditions:  

Unavailable: If your phone is turned off or your phone is out of the network service. 
Busy: When you are on the phone. 
No answer: If you do not answer your phone.   

To activate or deactivate Call Forwarding 

 

 

 

1. In phone dialer, tap Tools, Options and then Services .   

2. In Services , tap Call Forwarding  and then Get Settings (retrieving settings 
may take a few minutes). 

3. In Call forwarding either tick Forward all incoming phone calls and then 
enter a number in the box below – or select one or all of the other categories and 
enter numbers. 

 

Call Waiting  

This service allows you to receive another call during an active call. You can also turn this option off by selecting Do not notify 
me.  
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To activate or deactivate Call Waiting 
  

1. In phone dialer, tap Tools, Options and then Services . 

2. In Services , tap Call waiting and then Get Settings  (retrieving settings may 
take a few minutes). 

3. Then in Call waiting select Notify me or Do not notify me  and tap OK.  

 

 

 

Voice Mail and SMS  

By default your Pocket PC Phone will automatically detect and set your voice mail and SMS access numbers. However, you can 
view the settings if you want.  

To view your voice mail and SMS access numbers 

  

1. In phone dialer, tap Tools, Options and then Services . 

2. In Services , tap Voice mail and SMS, and then Get Settings (retrieving settings 
may take a few minutes). 

3. Then in Voice mail and SMS  type in the access numbers  and tap OK.  
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To find a network 
  

1. In phone dialer, tap Tools, 
Options and then Network . 

2. Tap Find Network  (retrieving 
settings may take a few 
minutes). 

 You can use this function when 
the network status is currently 
out of network service and you 
want to conduct a search. 

 

To select a network 
  

1. In phone dialer, tap Tools, Options and then Network. 

2. Select either Automatic or Manual in Network selection (retrieving settings 
may take a few minutes when you select Manual). 
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To set preferred networks 
  

1. In phone dialer, tap Tools, Options  and then Network . 

2. Select Set Preferred Networks (retrieving settings may take a few minutes). 
 
3. Select any network and re-prioritize the order for network usage. 
 
 

 If there are many mobile phone service providers available to you, enable this 
function to select a lower fee network. 

 

 

 

To select automatic pickup 
This feature, which instructs your phone to pick up the call automatically, is particularly helpful when you are in a hands-free 
environment. For example, if you are driving and using the earphone, the call will be picked up after a designated number of rings 
and your hands never have to leave the wheel. 
 

 

 

1. In phone dialer, tap Tools, Options  and then More. 

2. To enable, tick the box next to Answer incoming calls  without pressing Talk 
after rings  and choose the number of rings in the drop-down menu. 
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Using Key Lock  
Key Lock  enables you to lock the buttons on your Pocket PC Phone so that only the On/Off button will turn your Pocket PC 
Phone on. Locking your Pocket PC Phone in this way ensures you cannot switch the Pocket PC Phone on by accident, and 
consume unnecessary power.  
  

  
Enabling Key Lock when you are using your phone features will slow down your ability to answer a call. 

 

 

To enable Key Lock 
1. Tap Phone, Tools, Options, and then More. 
 
2. Under Hardware Key Lock, select Lock all buttons except Power button, and then OK. 
 

Enabling Broadcast Channels 
You can choose to receive real-time news and information, such as traffic news and weather reports. 

To enable Broadcast Channels 

 

 

1. Tap Phone, Tools, Options , and then More. 
 

2. Under Broadcast Channels  tick Enable, and then tap OK. 
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Additional Dialing Information 

To make an emergency call 
  

Enter the emergency number 911 then  or press the  button. 
 

  
 
1. Your Pocket PC Phone also provides international emergency number 112.  

This number can normally be used to make an emergency call in any country -
with/without a Smart Card inserted, as long as you are in a mobile phone 
service network.  

 
2. Some mobile phone service providers may require that a Smart Card  be 

inserted, and in some cases that the PIN has been entered as well. 
 
3. In some cases, other emergency numbers may also be available. Your mobile 

phone service provider may save additional local emergency numbers in the 
Smart Card. 

To make an international call 

 

 
1. Tap and hold the 0 key until the + sign appears. The + replaces the international 

prefix of the country from where you are calling. 
 
2. Enter the full phone number you want to dial. It includes country code, area 

code (without the leading zero) and phone number. 
 

3. Tap   or press the  button. 
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Chapter 5: Getting Connected 
You can use your Pocket PC Phone to exchange information with other mobile Pocket PC Phones as well as your PC, a network, 
or the Internet. You have the following connection options: 
 
?? Use the infrared (IR) port on your Pocket PC Phone to send and receive files between two Pocket PC Phones. 

?? Connect to your mobile Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using 
Inbox and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The communication software for creating 
a wireless ISP connection is already installed on your Pocket PC Phone. Your service provider will provide software needed 
to install other services, such as paging and fax services. 

?? Connect to the network at your company or organization where you work. Once connected, you can send and receive e -mail 
messages by using Inbox, view Web or WAP pages by using Pocket Internet Explorer, and synchronize with your PC. 

 
?? Connect to the virtual private network (VPN) at the company or organization where you work.  Many corporations have a 

need to extend their secure corporate Intranet to remote users.  In the past, Remote Access Servers (RAS) have been used. 
The remote user would need to use a dial-up connection to the corporate RAS server. This was considered secure since the 
phone lines were directly connected from the remote user to the RAS server, which is part of the corporate Intranet.  But with 
the advent of ready access to the Internet for many remote users, using the Internet to access the corporate Intranet was easier 
and much less expensive.  

 
The dilemma was how to keep corporate data secure while using the very public Internet. The answer was to implement a 
VPN solution. The textbook definition of a VPN is as follows: a combination of tunneling, encryption, authentication, and 
access control technologies and services used to carry traffic over the Internet, a managed IP network or a provider's 
backbone.  The VPN solution requires software on the remote user’s computer as well as a VPN server within the corporate 
Intranet. 
 
A tunneling protocol is a method to encrypt the data over the Internet. The encryption key is known to t he remote user and the 
server, so anyone trying to access the data along the Internet path would not be able to decrypt the data. There are currently 
three tunneling protocols that are used in the majority of VPNs: IP Security (IPSec), the Layer 2 Tunneling Protocol (L2TP) 
and the Point-to-Point Tunneling Protocol (PPTP).  Of the three PPTP is the most widely used.   Microsoft supports PPTP 
within Windows and the Pocket PC Phone.  
 
The T-Mobile network supports the use of these three protocols with our VPN -ready wireless data service.  Our VPN-ready 
wireless data rate plans will provide you with a dedicated public Internet protocol address (known as an Internet 3 address or 
I3).   Be sure to advise your sales representative that you will need a VPN-ready wireless data rate plan.  
 
If you plan to use your Pocket PC Phone to access the Internet only, then our standard Internet-ready wireless data rate plans 
will be adequate.  Be sure to check with your company’s IT department as to the requirements for your corporate VPN 
solution. 
 
Once connected, the added security of a VPN means that you can access the full resources of your company’s network. For 
example, you can use File Explorer to access the files of computers on that network.    

Getting Help on Connecting 
More information on creating a connection to work or the Internet, as well as information on additional procedures, can be found 
in the following locations: 
 
?? The accompanying Welcome Guide. 

?? Online Help on the Pocket PC Phone. Tap  and then Help. Tap View, All Installed Help, and then Inbox or 
Connections. 

 
?? ActiveSync Help on the desktop PC.  In ActiveSync, click Microsoft ActiveSync Help on the Help menu. 
For troubleshooting information, see the Poc ket PC Web site at: http://www.microsoft.com/mobile/pocketpc 
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Chapter 6: Wireless Data Programs 
As well as wireless voice communication your Pocket PC Phone has built-in support for a range of wirele ss data communication 
forms. You can: 

1. Browse the Web and view WAP-enabled sites. 

2. Send SMS text messages. 

3. Send and receive e-mail. 

4. Synchronize with your desktop PC remotely. 

5. Send and receive information from another IR-compatible Windows-powered Pocket PC Phone.  

 Except in the case of No. 5 above, in order to use these features the following steps must have been completed: 

1. Your mobile phone service provider supports data transmission.  (For further information contact your mobile phone 
service provider).  

2. You have an account for Web and e-mail access with an ISP or at a network through your company or another organization. 
(It may be that your mobile phone service provider is acting as your ISP) 

3. You have set up a dial-up connection to an ISP or network on y our Pocket PC Phone.  

4. Your wireless connection to your mobile service provider is turned on but you are not using it. 

5. You have switched on one of the dial-up networking connections established in No. 4 above.  

 Pocket Internet Explorer: Browsing Web and WAP pages 
 
Use Microsoft ?  Pocket Internet Explorer to view Web HTML, cHTML and WAP pages. You can browse in either of these 
ways: 

?? During synchronization with your PC, download your favorite links and mobile favorites that are stored in the Mobile 
Favorites folder in Internet Explorer on the PC. 

?? Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you will need to create the 
connection first, as described in the separate Welcome Guide. 

When connected to an ISP or network, you can also download files and programs from the Internet or Intranet. 
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Using Pocket Internet Explorer 

 

To switch to Pocket Internet Explorer: 

?? Tap  and then Internet Explorer. 

You can use Pocket Internet Explorer to browse mobile 
favorites and channels that have been downloaded to your 
Pocket PC Phone without connecting to the Internet. You 
can also connect to the Internet through an ISP or a 
network connection and browse Web/WAP pages. 

To view Mobile Favorites and Channels 
 

1. Tap the Favorites button to display your list of 
favorites.  

2. Tap the page you want to view.  

3. You will see the page that was downloaded the last 
time you synchronized with your desktop PC. If the 
page is not on your Pocket PC Phone, the favorite 
will be dimmed. You will need to synchronize with 
your desktop PC again to download the page to your 
Pocket PC Phone, or connect to the Internet to view 
the page. 

To browse the Internet 
1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Welcome Guide. 

2. To connect and start browsing, do one of the following: 

?? Tap the Favorites button, and then tap the favorite you want to view. 

?? Tap View and then Address Bar . In the address bar that appears at the top of the screen, enter the Web address you want 
to visit and then tap Go. Tap the arrow to choose from previously entered addresses. 

 
 To add a favorite link while using the Pocket PC Phone, go to the page you 

want to add, tap and hold on the page and tap Add to Favorites . 
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The Mobile Favorites Folder 
Only items stored in the Mobile Favorites folder in the Favorites folder in Internet Explorer on your desktop PC will be 
synchronized with your Pocket PC Phone. This folder was created automatically when you installed ActiveSync.  

Favorite Links 
During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop PC is synchronized with Pocket 
Internet Explorer on your Pocket PC Phone. Both your PC and your Pocket PC Phone are updated with changes made to either list 
each time you synchronize. Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your 
Pocket PC Phone, and you will need to connect to your ISP or network to view the content. For more information on 
synchronization, see ActiveSync Help on the desktop PC. 

Mobile Favorites  
If you are using Microsoft Internet Explorer 5.0 or later on your desktop PC, you can download mobile favorites to your Pocket 
PC Phone. Synchronizing mobile favorites downloads Web content to your Pocket PC Phone so that you can view pages while 
you are disconnected from your ISP and desktop PC. 

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites quickly. 

To create a Mobile Favorite 
1. In Internet Explorer on your desktop PC, click Tools and then Create Mobile Favorite. 

2. To change the link name, enter a new name in the Name box.  

3. Optionally, in Update, select a desired update schedule. 

4. Click OK. Internet Explorer downloads the latest version of the page to your desktop PC. 

5. Limit the number of downloaded linked pages.  In Internet Explorer on the desktop PC, click Favorites.  Then move your 
mouse through Mobile Favorites to the mobile favorite you want to change.  Finally, right-click the mobile favorite and then 
Properties .  In the Download tab, specify 0 or 1 for the number of linked pages you want to download. 

 
6. Synchronize your Pocket PC Phone and desktop PC. Mobile favorites that are stored in the Mobile Favorites folder in 

Internet Explorer are downloaded to your Pocket PC Phone. 

 If you did not specify an update schedule in step 3, you will need to manually download content to 
keep the information updated on your desktop PC and Pocket PC Phone.  Before synchronizing 
with your Pocket PC Phone, in Internet Explorer on your desktop PC, click Tools and then 
Synchronize . You will see the last time content was downloaded to the desktop PC, and you can 
manually download content if needed. 
 

 You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet 
Explorer on your desktop PC, click View, Toolbars and then Customize. 

Saving Pocket PC Phone Memory 
Mobile favorites take  up storage memory on your Pocket PC Phone. To minimize the amount of memory used: 

?? In ActiveSync on your desktop PC, click Options, select Favorites/Internet Explorer, tap Settings and then Customize. 
You can then deselect Synchronize Images, Synchronize Sound and/or Synchronize offline content pages , to stop 
pictures and sounds, or some mobile favorites from being downloaded to the Pocket PC Phone. For more information, see 
ActiveSync Help. 

?? Limit the number of downloaded linked pages. In Internet Explorer on the desktop PC, click Favorites, then move your 
mouse through Mobile Favorites to the mobile favorite you want to change. Finally, right-click the mobile favorite and then 
Properties . In the Download tab, specify 0 or 1 for the number of linked pages you want to download. 
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To browse the Internet 
1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Welcome Guide . 

2. To connect and start browsing, do one of the following: 

?? Tap the Favorites  button, and then tap the favorite you want to view. 
 
?? Tap View and then Address Bar . In the address bar that appears at the top of the screen, enter the Web address you want 

to visit and then tap Go. Tap the arrow to choose from previously entered addresses. 
 

 To add a favorite link while using the Pocket PC Phone, go to the page you 
want to add, tap and hold on the page and tap Add to Favorites . 

 

Using AvantGo Channels 
AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your Pocket PC Phone. Then, you synchronize your Pocket PC Phone and desktop 
PC, or connect to the Internet to download the content.  For more information, visit the AvantGo Web site. 

To sign up for AvantGo 
1. In ActiveSync options on the desktop PC, turn on synchronization for the AvantGo information type. 
2. In Pocket Internet Explorer on your Pocket PC Phone, tap the Favorites  button to display your list of favorites. 

3. Tap the AvantGo Channels link. 

4. Follow the directions on the screen. You will need to synchronize your Pocket PC Phone with your desktop PC and then tap 
the My Channels button to complete the AvantGo setup. 

When synchronization is complete, tap the AvantGo Channels link in  your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove  link. 

 MSN Messenger: Instant Messaging 
MSN Messenger on your Pocket PC Phone is an instant messaging program that lets you: 
 
?? See who is online. 
 
?? Send and receive instant messages. 

?? Have instant message conversations with groups of contacts. 

To use MSN Messenger, you must have a Microsoft Passport™  account or a Microsoft Exchange e-mail account. You must have 
a Passport to use MSN Messenger Service. If you have a Hotmail?  or MSN account, you already have a Passport. Once you have 
obtained either a Microsoft Passport or a Microsoft Exchange account, you are ready to set up your account. 
 

 Sign up for a Microsoft Passport account at http://www.passport.com. Get 
a free Microsoft Hotmail e-mail address at http://www.hotmail.com. 

 

To switch to MSN Messenger 

Tap , Programs, and then tap MSN Messenger . 
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Setting Up An Account  
Before you can connect, you must enter Passport or Exchange account information. 

  
To set up an account and sign in: 
1. In the Tools  menu, tap Options. 
2. In the Accounts tab, enter your Passport or Exchange account information. 
3. To sign in, tap the sign-in screen and enter your e-mail address and password.
 
To change from your Exchange account to your Passport account and sign 
in: 
1. In the Tools  menu, tap Options. 
2. In the Accounts tab, tick Enable Passport account and enter your Passport 

account information.  Under Sign in using this account first, tick Passport 
account, and then tap OK. 

3. To sign in, tap the sign-in screen and enter your e-mail address and password.

 If you already use MSN Messenger on your desktop PC, your contacts will show 
up on your Pocket PC Phone without being added again. 

Working with Contacts 
  

?? The MSN Messenger window shows all of your 
messenger contacts at a glance, divided into Online  and 
Not Online categories.  While connected, you can chat, 
send e-mail, block the contact from chatting with you, 
or delete contacts from your list using the pop-up menu.

 To see others online without being seen, in the Tools menu, tap My Status and select Appear Offline. If you 
block a contact, you will appear offline but will remain on the blocked contact’s list. To unblock a contact, tap 
and hold the contact, then tap Unblock on the pop-up menu. 
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Chatting with Contacts 
  

?? Tap a contact name to open a chat window. Enter your 
message in the text entry area at the bottom of the 
screen, or tap My Text to enter a preset message, and 
tap Send. To invite another contact to a multi-user chat, 
in the Tools menu, tap Invite and tap the contact you 
want to invite. 

 

 To switch back to the main window without closing a chat, tap the 
Contacts button. To revert back to your chat window, tap Chats and 
select the person whom you were chatting with. 

 
  

?? To know if the contact you are chatting with is 
responding, lo ok for the message under the text entry 
area. 

?? For more information on using MSN Messenger, tap 

 and then Help. 

 Inbox: Sending and Receiving E-mail or SMS 
Use Inbox to send and receive e-mail messages in either of these ways:  
 
?? Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop PC. 
?? Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network. 

You also can use Inbox to send and receive SMS text messages.  Inbox supports 8 bits data with class 0, 1, 2, 3 plus Unstructured 
Supplementary Service Data (USSD). 

 

 



Page 70 

Synchronizing E-mail Messages 
E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop PC. 
 
During synchronization: 
 
?? Messages are copied from the mail folders of Exchange or Outlook on your desktop PC to the ActiveSync folder in Inbox on 

your Pocket PC Phone.  By default you will receive messages from the past five days only, and only the first 100 lines of each 
message. 

 
?? E-mail messages in the Outbox folder on your Pocket PC Phone are transferred to Exchange or Outlook, and then sent from 

those programs. 
?? E-mail messages in folders must be selected in ActiveSync on your desktop PC in order to be transferred. 
 

Connecting Directly to an E-mail Server 
In addition to synchronizing e-mail messages with your desktop PC, you can send and receive e-mail messages by connecting to 
an e -mail server using a modem or network card connected to your Pocket PC Phone. You will need to set up a remote connection 
to a network or an ISP, and a connection to your e-mail server.  
 
When you connect to the e-mail server, new messages are downloaded to the Pocket PC Phone Inbox folder, messages in the 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the Inbox folder. 
Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your PC. When you delete a 
message on your Pocket PC Phone, it is also deleted from the e -mail server the next  time you connect - based on the settings you 
selected in ActiveSync. 
 
You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your Pocket PC Phone. 
When working offline, once you have downloaded new message headers or partial messages, you can disconnect from the e -mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you have marked for retrieval and sends the messages you have composed. 
 

Using the Message List 
  

?? Messages you receive are displayed in the message list. 
By default, the most recently received messages are 
displayed in the list first. 
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?? When you receive a message, tap it to open it. Unread 

messages are displayed in bold. 
 

 
When you connect to your e -mail server or synchronize with your desktop PC, by default, you will receive messages from the last 
five days only and only the first 100 lines of each new message. The original messages remain on the e-mail server or your 
desktop PC.  
 
You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the 
message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the 
Inbox message list give you visual indication of message status. 
 
You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
them at any time: 
 
?? Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help. 
 
?? Change options for direct e-mail server connections in Inbox on your Pocket PC Phone. Tap Tools and then tap Options . On 

the Service tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service. 
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Creating an SMS text message or E-mail 
  

1. Tap New.  

2. In the To field, enter either e-mail address or SMS 
number of one or more recipients, separating them with a 
semicolon, or select a name from the contact list by 
tapping the Address Book button. All e-mail addresses 
entered in the e-mail fields in Contacts appear in the 
Address Book. 

3. Compose your message. To enter preset or frequently 
used messages, tap My Text and select a message. 

4. Tap Send when you have finished the message. If you are 
working offline, the message is moved to the Outbox 
folder and will be sent the next time you connect. 

 
 
1. Whether you wa nt to send or read E-mail or a SMS, you 

can swap by tapping Services  then choosing what service 
you want. 

2. If you are sending an SMS message and want to know if it 
was received, tap Edit, Options , and select Request SMS 
text message delivery notification before sending the 
message. 

 

Managing Messages and Folders 
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox 
and Sent Items. The Deleted Items folder contains messages that have been deleted on the Pocket PC Phone. The behavior of the 
Deleted and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the 
Message tab, select your options. 
 
If you want to organize messages into additional folders, tap Tools, and then Manage Folders  to create new folders. To move a 
message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu. 
 
 
 

Folder behavior with a direct connection to an e-mail server 
The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4.  
 
1. If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your Pocket 

PC Phone. You can select to synchronize additional folders by designating them for ActiveSync. The folders you created and 
the messages you moved will then be mirrored on the server. For example, if you move two messages from the Inbox folder 
to a folder named ‘Family’, and you have designated ‘Family’ for synchronization, the server creates a copy of the ‘Family’ 
folder and copies the messages into that folder. You can then read the messages while away from your PC. 

 
2. If you use SMS, messages are stored in the Inbox folder of SMS category. 
 
3. If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

Pocket PC Phone and their copies on the mail server. The next time you connect, the mail server will see that the messages 
are missing from the Pocket PC Phone Inbox and delete them from the server. This prevents you from having duplicate 
copies of a message, but it also means that you will no longer have access to messages that you move to folders created from 
anywhere except the Pocket PC Phone. 

 
4. If you use IMAP4, the folders you created and the e-mail messages you moved are mirrored on the server. Therefore, 
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messages are available to you anytime you connect to your mail server, whether it is from your Pocket PC Phone or PC. This 
synchronization of folders occurs whenever you connect to your mail server; create new folders, or rename/delete folders 
when connected.  
 

Transferring Items Using Infrared 
Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Pocket PC Phones. 

To send information 
1. Switch to the program where you created the item you want to send and locate the item in the list. 

2. Align the IR ports so that they are unobstructed and within close range. 

3. Tap and hold the item, and tap Beam Item on the pop-up menu. 

 You can also send items, but not folders, from File Explorer. Tap and hold 
the item you want to send, and then tap Beam File on the pop-up menu. 

To receive information 
1. Align the IR ports so that they are unobstructed and within close range. 

2. Have the owner of the other Pocket PC Phone send the information to you. Your Pocket PC Phone will automatically receive 
it. 

Terminal Services Client 
Using the Terminal Services Client, you can log onto a Windows NT server-type PC that is running Terminal Services software 
and use all of the programs that are available on that PC from your Pocket PC Phone. For example, instead of running Microsoft 
Pocket Word, you can run the PC version of Microsoft Word and access all of the .doc files on that PC from your Pocket PC 
Phone. 

 You cannot use Transcriber when entering information in Terminal 
Services . You must use Keyboard, Block Recognizer, or Letter 
Recognizer. 

 

To connect to a Terminal Server 
Start a remote connection to the server via your wireless modem connection. 
 

1. Tap , Programs, and then Terminal Services Client. 
 
2. To connect to a server you have previously connected to, in Recent Servers , tap a server.  
 
3. To connect to a new server, enter the server’s name in the Server box. Select the limit size of desktop PC to fit on the 

screen check box only when using applications that have been specifically sized for use with your Pocket PC Phone. 
 
4. Tap Connect. 
 

 If the network administrator has configured Terminal Services Client to 
reconnect to disconnected sessions, and you previously disconnected from 
a Terminal Server without ending the session, the Terminal Services Client 
reconnects to that session. 
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To disconnect without ending a session 
The following commands must be accessed from the Start menu in the Terminal Services window used to access the PC’s 
commands.  Do not u se the Start menu on your Pocket PC Phone.  

1. In the Terminal Services Client window, tap , and then Shutdown . 
 
2. Tap Disconnect. 
 
    

 If the network administrator has configured Terminal Services Client to 
reconnect to disconnected sessions, you will be reconnected to this session 
the next time you connect to this server.  

 

To disconnect and end a session 

1. In the Terminal Services Client window, tap  and then Shutdown . 
 
2. Tap Log Off. 
 

To navigate within Terminal Services Client 
Once connected to the server, the PC’s screen may more than fill your Pocket PC Phone’s screen. If scroll bars are displayed on 
the server’s screen, you will see more than one set of scroll bars on your Pocket PC Phone: 
  

?? One to scroll information on the PC, and one to scroll the PC display through the Terminal Services window in Terminal 
Services Client. 

?? To ensure you are scrolling the PC display through Terminal Services Client, use the four directional buttons at the 
bottom of the Terminal Services Client screen. 

?? To better fit information on your Pocket PC Phone’s screen, select Limit size of server desktop PC to fit on this screen.  
For best effect, programs on the PC should be maximized. 

 

To improve display performance 
Display performance is improved by decreasing the time it takes for the screen to be refreshed on the PC. 

1. On your PC select , Settings  and Control Panel. 
2. Double click Display. 
3. Clear the Use transition effects for menus and tool tips  check box under the Effects tab. 
 

To improve browser performance 
Performance with Internet Explorer on the PC is improved by decreasing the time it takes for Web pages to be refreshed. 
In Internet Explorer on your PC, select Tools , Internet Options , Advanced, and then clear the Use smooth scrolling check box. 
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Chapter 7 : Microsoft ActiveSync 
 
Using Microsoft ActiveSync, you can synchronize the information on your desktop PC with the information on your Pocket PC 
Phone.  Synchronization compares the data on your Pocket PC Phone with your desktop PC and updates both with the most 
recent information.  For example: 
 
?? Keep Pocket Outlook data up-to-date by synchronizing your Pocket PC Phone with Microsoft Outlook data on your PC.  
?? Synchronize Microsoft Word and Microsoft Excel files between your Pocket PC Phone and PC. Your files are automatically 

converted to the correct format. 
 

 By default, ActiveSync does not automatically synchronize all types of 
information. Use ActiveSync options to turn synchronization on and off 
for specific information types. 

 
With ActiveSync you can also: 
 
?? Back up and restore your Pocket PC Phone data.  
?? Copy (rather than synchronize) files between your Pocket PC Phone and PC.  
?? Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your PC or only when you choose the synchronize command. 
?? Select which information types are synchronized and control how much data is synchronized. For example, you can choose 

how many weeks of past appointments you want synchronized. 
 
After installation is complete, the ActiveSync Setup Wizard helps you connect your Pocket PC Phone to your PC, set up a 
partnership so you can synchronize information between your Pocket PC Phone and your PC, and customize your 
synchronization settings. Your first synchronization process will automatically begin when you finish using the wizard. 
  
After your first synchronization, take a look at Calendar, Contacts, and Tasks on your Pocket PC Phone. You will notice that 
information you have stored in Microsoft Outlook on your PC has been copied to your Pocket PC Phone, and you did not have to 
type a wo rd. Disconnect your Pocket PC Phone from your PC and you are ready to go! 
 
Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your 

Pocket PC Phone. To switch to ActiveSync on your Pocket PC Phone, tap  and then tap ActiveSync. Note that if you have a 
wireless LAN card, you can synchronize remotely from your Pocket PC Phone. 
 
For information about using ActiveSync on your PC, start ActiveSync on your PC and then see ActiveSync Help. 
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?? For more information about ActiveSync on your 

Pocket PC Phone, switch to ActiveSync, tap  and 
then tap Help. 

 

Synchronizing Files 
When you first set up a connection, or by tapping Options  in ActiveSync on your desktop PC, under Mobile Pocket PC Phone 
you can see the list of programs you can synchronize.  This list includes: Calendar, Contacts , Tasks, Inbox, Files , Pocket 
Access, Favorites and AvantGo channels. Files  is a folder specially-created on your desktop PC in My Documents into which 
you must place all files (Word, Excel etc.) you wish to synchronize.  
 

To synchronize files 
 
1. Select Files  in ActiveSync, and then OK to create a new folder. 
 
2. Use Windows Explorer on your desktop PC to find this folder – usually called “My Documents” pre-fixed by the name you 

gave to your connection – then copy files you want to synchronize into this folder. 

3. Tap Synchronize in ActiveSync. 
 

For more information about ActiveSync on your Pocket PC Phone, switch to ActiveSync, tap  and then tap Help. 
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Chapter 8: Microsoft Pocket Outlook 
 
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox and Notes. You can use these programs individually or 
together.  For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox.  
 
Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your PC with your Pocket 
PC Phone. You can also synchronize this information directly with a Microsoft Exchange server.  Each time you synchronize, 
ActiveSync compares the changes you made on your Pocket PC Phone and PC or server, and updates both with the latest 
information.  For information on using ActiveSync, see ActiveSync Help on the PC. 
 

You can switch to any of these programs by tapping them on the  menu. 

 Calendar: Scheduling Appointments and Meetings 
 
 

 
?? Use Calendar to schedule appointments, including 

meetings and other events. You can check your 
appointments in one of several views (Agenda, Day, 
Week, Month, and Year) and easily switch views by using 
the View menu. 

 
 

 You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the 
Tools menu. 
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To create an appointment 
 

 

 

1.  If you are in Day or Week view, tap the desired date and time 
for the appointment. 

2. Tap New.  

3. Using the input panel, enter a description and a location. Tap 
first to select the field.  

4. If needed, tap the date and time to change them. 

5. Enter other desired information. You will need to hide the 
input panel to see all available fields. 

6. To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, 
see Notes: Capturing Thoughts and Ideas later in this 
chapter. 

7. When finished, tap OK to return to the calendar.  

 If you select Remind me in an appointment, your Pocket PC Phone will remind you according 

to the options set in , Settings, Personal tab, Sounds & Reminders. 

Using the Summary Screen 
  

?? When you tap an appointment in Calendar, a summary 
screen is displayed. To change the appointment, tap Edit. 

 

Creating Meeting Requests 
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options . If you send and receive e-mail messages through ActiveSync, select 
ActiveSync. 
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To schedule a meeting 
  

1. Create an appointment. 

2. In the appointment details, hide the input panel, and then tap 
Attendees. 

3. From the list of e-mail addresses you have entered in 
Contacts, select the meeting attendees.  

4. The meeting notice is created automatically and placed in 
the Outbox folder. 

 
For more information on sending and receiving meeting 
requests, see Calendar Help and Inbox Help on your Pocket PC 
Phone. 

 Contacts: Tracking Friends and Colleagues 
  

?? Contacts maintains a list of your friends and 
colleagues so that you can easily find the 
information you are looking for, whether you are 
at home or on the road. Using the Pocket PC 
Phone infrared (IR) port, you can quickly share 
Contacts information with other Pocket PC Phone 
users. 

 

 To change the way information is displayed in the list, tap Tools  and then Options . 
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To create a contact 

 

1. Tap New. 

2. Using the input panel, enter a name and other contact 
information. You will need to scroll down to see all 
available fields. 

3. To assign the contact to a category, scroll to and tap 
Categories  and select a category from the list. In the 
contact list, you can display contacts by category. 

4. To add notes, tap the Notes tab. You can enter text, 
draw, or create a recording. For more information on 
creating notes, see Notes: Capturing Thoughts and 
Ideas later in this chapter.  

5. When finished, tap OK to return to the contact list. 

To find a contact 

 

There are 6 ways to find a contact: 
1. Press and hold the upside of the navigation pad until 

alphabetical letters appear on the screen in large type. 
Then use the navigation pad to scroll through the 
alphabet and select a letter.  

 
2. Tap one of the grouping of letters displayed across the 

top of the screen.   
 
3. In the contact list, enter a contact name in the box under 

the navigation bar. To show all contacts again, clear text 
from the box or tap the button to the right of the box.  

4. In the contact list, tap the category list (labeled All 
Contacts by default) and select the type of contact that 
you want displayed. To show all contacts again, select 
All Contacts. To view a contact not assigned to a 
category, select None.  

 
5. To view the names of companies your contacts work 

for, in the contact list, tap View > By Company. The 
number of contacts that work for that company will be 
displayed to the right of the company name.  

6. Tap , Find, enter the contact name, select Contacts
for the type and then tap Go. 
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Using the Summary Screen 
  

?? When you tap a contact in the contact list, a summary 
screen is displayed. To change the contact information, 
tap Edit. 

 

 Tasks: Keeping a To Do List 
  

?? Use Tasks to keep track of what you have to do.  

 To change the way information is displayed in the list, tap Tools and then Options. 
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To create a task 
  

1. Tap New. 

2. Using the input panel, enter a description. 

3. You can enter a start date and due date or enter other 
information by first tapping the field. If the input 
panel is open, you will need to hide it to see all 
available fields. 

4. To assign t he task to a category, tap Categories  and 
select a category from the list. In the task list, you can 
display tasks by category. 

5. To add notes, tap the Notes tab. You can enter text, 
draw, or create a recording. For more information on 
creating notes, see Notes: Capturing Thoughts and 
Ideas  later in this chapter. 

6. When finished, tap OK to return to the task list. 

 

 To quickly create a task with only a subject, tap Entry Bar on the Tools 
menu. Then, tap Tap here to add a new task and enter your task 
information. 

 

Using the Summary Screen 
  

?? When you tap a task in the task list, a summary screen 
is displayed. To change the task, tap Edit. 
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 Notes: Capturing Thoughts and Ideas 
 
 

 

?? Quickly capture thoughts, reminders, ideas, drawings, 
and phone numbers with Notes. You can create a written 
note or a recording. You can also include a recording in a 
note. If a note is open when you create the recording, it 
will be included in the note as an icon. If the note list is 
displayed, it will be created as a stand-alone recording. 

 

To create a note 
  

1. Tap New. 

2. Create your note by writing, drawing, typing and 
recording. For more information about using the input 
panel, writing and drawing on the screen, and creating 
recordings, see Chapter 3. 
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Chapter 9: Companion Programs 
 
The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, Microsoft Money, Windows Media Player 
for the Pocket PC Phone and Microsoft Reader.  

To switch to a companion program on your Pocket PC Phone, tap Programs on the  menu, and then tap the program name. 

 Pocket Word 
Pocket Word works with Microsoft Word on your desktop PC to give you easy access to copies of your documents. You can 
create new documents on your Pocket PC Phone, or you can copy documents from your PC to your Pocket PC Phone. 
Synchronize documents between your PC and your Pocket PC Phone so that you have the most up-to-date content in both 
locations. 

Use Pocket Word to create documents such as letters, meeting minutes and trip reports. To create a new file, tap , Programs , 
Pocket Word, and then New. A blank document appears. Or, if you have selected a template for new documents in the Options 
dialog box under Tools, that template appears with appropriate text and formatting already provided. You can open only one 
document at a time; when you open a second document, you will be asked to save the first. You can save a document you create 
or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).  

Pocket Word contains a list of the files stored on your Pocket PC Phone. Tap a file in the list to open it. To delete, make copies of, 
and send files, tap and hold a file in the list. Then select the appropriate action on the pop-up menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 You can change the zoom magnification by tapping View and then Zoom. Then 
select the percentage you want. Select a higher percentage to enter text and a lower 
one to see more of your document. 
If you are opening a Word document created on a PC, select Wrap to Window on 
the View menu so that you can see the entire document. 

 
You can enter information in Pocket Word in one of four modes (writing, drawing, typing and recording) which are displayed on 
the View menu. Each mode has its own toolbar that you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar. 
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Typing Mode 
  

?? Using the input panel, enter typed text into the 
document. For more information on entering 
typed text, see Chapter 3. 

?? To format existing text and to edit text, first 
select the text. You can select text as you do in 
an MS-Word document, using your stylus 
instead of the mouse to drag through the text 
you want to select. You can search a document 
to find text by tapping Edit and then 
Find/Replace. 

 

Writing Mode 
  

?? In writing mode, use your stylus to write 
directly on the screen. Ruled lines are 
displayed as a guide, and the zoom 
magnification is greater than in typing mode 
to allow you to write more easily. For more 
information on writing and selecting writing, 
see Chapter 3. 

 

 If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can 
be edited and manipulated as described in the following section.  
Written words are converted to graphics (metafiles) when a Pocket Word document is 
converted to a Word document on your PC. 
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Drawing Mode 
  

?? In drawing mode, use your stylus to draw on 
the screen. Gridlines appear as a guide. 
When you lift your stylus off the screen after 
the first stroke, you will see a drawing box 
indicating the boundaries of the drawing. 
Every subsequent stroke within or touching 
the drawing box becomes part of the 
drawing. For more information on drawing 
and selecting drawings, see Chapter 3. 

 

Recording Mode 
In recording mode, embed a recording into your document. Recordings are saved as .wav files. For more information on 
recording, see “Recording a Message” in Chapter 3. 

For more information on using Pocket Word, tap  and then Help. 

 Pocket Excel 
Pocket Excel works with Microsoft Excel on your desktop PC to give you easy access to copies of your workbooks. You can 

create new workbooks on your Pocket PC Phone, or you 
can copy workbooks from your PC to your Pocket PC 
Phone. Synchronize workbooks between your PC and 
your Pocket PC Phone so that you have the most 
up-to-date content in both locations. 

Use Pocket Excel to create workbooks, such as expense 

reports and mileage logs. To create a new file, tap , 
Programs , Pocket Excel and then New. A blank 
workbook appears. Or, if you have selected a template 
for new workbooks in the Options  dialog box under 
Tools, that template appears with appropriate text and 
formatting already provided. You can open only one 
workbook at a time; when you open a second workbook, 
you will be asked to save the first. You can save a 
workbook you create or edit in a variety of formats, 
including Pocket Excel (.pxl) and Excel (.xls). 

 

 



Page 87 

 

Pocket Excel contains a list of the files stored on your Pocket PC Phone. Tap a file in the list to open it. To delete, make copies of, 
and send files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu. 
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting and filtering. To display the toolbar, 
tap View and then Toolbar.  
 

 If your workbook contains sensitive information, you can protect it with a password. To do so, open 
the workbook, tap Edit and then Password. Every time you open the workbook, you will need to enter 
the password, so choose one that is easy for you to remember but hard for others to guess. 

Tips for Working in Pocket Excel 
Note the following when working with large worksheets in Pocket Excel: 
 
?? View in full screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full screen 

mode, tap Restore. 

?? Show and hide window elements. Tap View and then tap the elements you want to show or hide. 
 
?? Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes . You 

might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through a 
sheet. 

 
?? Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you want 

it. To remove the split, tap View and then Remove Split. 
 
?? Show and hide rows and columns. To hide a row or column, select a cell in the row or column you want to hide. Then tap 

Format, Row or Column, and then Hide. To show a hidden row or column, tap Tools, Go To and then type a reference that 
is in the hidden row or column.  Tap Format, Row or Column and Unhide. 

 Windows Media Player for Pocket PC Phone 
 
Use Microsoft Windows Media Player for Pocket PC Phone to play digital audio and video files that are stored on your Pocket PC 

Phone or on a network. To switch to Windows Media Player for Pocket PC Phone, tap , Programs , and then tap Windows 
Media. 
 



Page 88 

  
?? Use Microsoft Windows Media Player on your PC to 

copy digital audio and video files to your Pocket PC 
Phone. You can play Windows Media and MP3 files 
on your Pocket PC Phone. 

?? For more information about using Windows Media 

Player for Pocket PC Phone, tap , and then tap 
Help. 

 

 Microsoft Reader 
Use Microsoft Reader to read e-Books on your Pocket PC Phone.  Download books to your PC from your favorite e-Book Web 
site. Then use ActiveSync to copy the book files to your activated Pocket PC Phone. The books appear in the MS-Reader Library, 
where you can tap them in the list to open them.  
 
Each book consists of a cover page, an optional table of contents and the pages of the book. You can: 
 

  

?? Page through the book by using the Up/Down control on your Pocket PC 
Phone or by tapping the page number on each page. 

?? Annotate the book with highlighting, bookmarks, notes and drawings. 
?? Search for text and look up definitions for words. 
?? The guidebook contains all the information you will need to use the 

software. To open the guidebook, tap Help on the Reader command bar. 
Or, on a book page, tap and hold on the book title and then tap Help on the 
pop-up menu. 

?? To switch to Microsoft Reader, tap , Programs  and then Microsoft 
Reader. 
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Getting Books on Your Pocket PC Phone 
You can purchase and download book files from the Web to your desktop PC and then synchronize them with your Pocket PC 
Phone.  However, you must have activated your Po cket PC Phone (you only need to activate it once);  have an activated copy of 
Microsoft Reader on your PC, and have set up synchronization for Files  in ActiveSync. 

 

1. Open ActiveSync  on your desktop PC and check you have selected synchronize Files.  If you h ave done so it will appear 
under Information Type.   If you have not click Options , Sync options , tick Files  and then OK from the pop-up menu.  
The pop-up menu is telling you your computer will create a folder in which you must put files you wish to synchronize. 

2. If you have not already activated your Pocket PC Phone, open a web browser, go to http://das.Microsoft.com/activate  
and follow the instructions. 

3. Go to www.microsoft.com/reader/shop.asp for a list of retailers selling Microsoft Reader e-Books. 

4. If you do not have a copy of Microsoft Reader on your PC, go to one of the retailers listed above and download a free 
copy from their site.  Then activate it as described above. 

5. Go to one of the Microsoft Reader e-Book sites and follow the instructions in the site for choosing, purchasing and 
downloading a book to your desktop PC.  

6. Use Windows Explorer  on your desktop PC to locate the Microsoft Reader “My Library” folder and the “Pocket_PC 
My Documents” folder, find the book title in My Library and then copy it to Pocket_PC My Documents .  ActiveSync 
will then download the files from your PC to your activated Pocket PC Phone. 

 

Sample books and a dictionary are also included in the Microsoft Reader folder in the Extras folder on the Pocket PC 
Companion CD.  

 

Using the Library 
The Library is your Reader home page; it displays a list of all books stored on your Pocket PC Phone or storage card. 
 

  

To open the Library: 
?? On the Reader command bar, tap Library.  
?? On a book page, tap the book title and then tap 

Library on the pop-up menu. 
 
To open a book: 
?? Tap its title in the Library list.  
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Reading a Book 
  

Each book consists of a cover page, an optional table 
of contents and the pages of the book. Navigation 
options are listed in the bottom portion of the cover 
page.  
 
The first time you open a book, you will probably want 
to go to the first page or to the table of contents, if there 
is one.  
 
Subsequently, whenever you open the book, you will 
be automatically taken to the last page read. 
In addition to the text, each book page includes a page 
number and book title.  
 
You can also page through a book by using the Up/ 
Down control on your Pocket PC Phone. 

Using Reader Features 
Reading a book electronically gives you several options not available with paper books. These options are available from any 
book page. 
 
Select text by dragging across the text on the page. Then, tap an option on the pop-up menu as described here: 
 
?? Search for Text. Find text in a book by tapping Find on the pop-up menu. Enter the word you want to search for, and tap the 

desired Find option. Reader highlights found text on the page. To close Find, tap outside the box. To return to your original 
page, tap the title and then tap Return on the pop-up menu. 

?? Copy Text. You can copy text from books that support this feature into any program that accepts text. On a book page, select 
the text you want to copy. Then tap Copy Text on the pop-up menu. The text can be pasted into the program of your choice. 

?? Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon appears in the right margin. You can add 
multiple bookmarks to a book. Then, from anywhere in the book, tap the bookmark icon to go to the bookmarked page. 

?? Highlights . When you highlight text, it appears with a colored background.  
?? Notes . When you attach a note to text, you enter the text in a note pad that appears on top of the book page. A Note icon will 

display in the left margin. To show or hide the note, tap the icon. 
?? Drawings . When you add a drawing, a Drawing icon appears in the bottom-left corner of the page, and drawing tools appear 

across the bottom of the page. Draw by dragging your stylus. 
?? To see a list of a book’s annotations, including bookmarks, highlights, text notes, and drawings, tap Annotations Index on 

the book’s cover page. You can tap an entry in the list to go to the annotated page. 
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Removing a Book 
  

?? When you finish reading a book, you can delete it to conserve 
space on your Pocket PC Phone. If a copy of the book is stored 
on your desktop PC, you can download it again at any time.  

?? To remove a book from your Pocket PC Phone, tap and hold the 
title in the Library list, and then tap Delete on the pop-up menu.

 

 Image Viewer 
 

 

 

 
?? Image Viewer allows  you to conveniently view 

high-resolution JPEG and BMP pictures, whether you 
are at home or on the road. 

?? Download images to your PC, and then use 
ActiveSync to copy the files to your Pocket PC Phone. 
The images appear in Image Viewer, where you can 
tap them in the list to open them.  

 Pictures can also be stored on a MMC or SD memory 
card to save memory on your Pocket PC Phone. Insert a 
card into the memory card slot and then copy or drag 
the pictures from your desktop PC to the My 
Documents directory on t he memory card. (If the 
memory card does not have a My Documents 
directory, you must create one first). 

Image Viewer is based in part on the work of the Independent JPEG group. 

Transferring Images to your Pocket PC Phone 
 
Pictures stored on your PC can be synchronized with Image Viewer on your Pocket PC Phone. Picture synchronization is not 
automatically selected in ActiveSync. For more information on synchronization, see ActiveSync Help on the desktop PC. 
 

Changing your Image List Layout 
 
You can choose to file your images in a list or as Viewer icons. 
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?? To file images in a list tap View and then Details. 
 
?? To file images as Viewer icons tap View and then Large Icons. 
 

Viewing Images   
 

1. View any image stored on your Pocket PC Phone by tapping Start, Programs , Image Viewer and then 
Browse. 

 
2. In Browse tap Find All or Change Folder – if you tap Change Folder a screen will appear listing the folders 

on your Pocket PC Phone. 
 

3. Before you choose one you can select to view the actual size of the picture or to f it it to the screen. To do so tap 
View, Zoom, Best Fit or Actual Size. 

Deleting an Image 
Hold the stylus firmly on the file name of the picture you want to delete, and then select Delete from the pop-up menu. 

Refreshing All Images 
On the pop-up menu, tap Refresh and the file information on the picture list will be refreshed.  

Arranging Order 
If you are working in Details  view, you can change the order in which the pictures are listed by tapping any of the following: file 
name, resolution, color numbers, file type, date or file size.  The list will be sorted on the criteria selected. 
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Appendix A: Character Recognizer 
 
Using Character Recognizer, you can write characters directly on your Pocket PC Phone screen with your stylus, just as you 
would on a pie ce of paper. The characters you write are translated into typed text. Use Character Recognizer anywhere you want 
to enter text - for example, to write a note or to fill in fields in a dialog box.  
 

 

 
?? The default writing mode for Character 

Recognizer is lowercase (Jot-compatible) mode. 
In this mode, you write characters in lowercase. 
The chart at the end of this appendix contains 
examples of how to write characters in lowercase 
mode.  

?? You can also choose to write in uppercase 
(Graffiti-compatible) mode. In this mode, you 
write characters in uppercase. If you prefer to 
write in uppercase mode, tap Uppercase Mode 
in Options on the input method menu. Whether a 
letter appears in uppercase or lowercase when it 
is converted to typed text depends on where in 
the input panel you write it - not on the mode you 
have selected. 

?? The Character Recognizer input panel is divided 
into three writing areas. Letters written in the left 
area (labeled ABC) create uppercase letters, and 
letters written in the middle area (labeled abc) 
create lowercase letters. Use the right area 
(labeled 123) for writing numbers, symbols, 
special characters and punctuation.  

 

 

 
?? The chart is a partial display of the characters you 

can write while in lowercase mode (the dot on 
each character is the starting point for writing). 
Remember that even though you write a letter in 
its lowercase form, the case of the text that is 
displayed depends on where you write the letter. 
For example, if you write a lowercase “a” in the 
ABC area, an uppercase “A” is displayed on the 
screen. 

For more information on using Character Recognizer and for demos of all characters, tap  on the Character Recognizer input 
panel.  
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Appendix B: Troubleshooting 

Resetting the Pocket PC Phone and Clearing Memory  
You can perform a soft reset or a full reset, depending on the situation.   A full reset, in the sense that you will lose all data and any 
software you have installed yourself, is similar to reinstalling your operating system (OS) on your desktop PC.  A soft  reset is 
similar to restarting your desktop PC. 
 
If your Pocket PC Phone responds slowly, stops responding or freezes, try soft resetting it. A soft reset causes the Pocket PC 
Phone to restart and re-adjust memory allocation. Unsaved data in open windows may be lost. 

To perform a soft reset 
?? Use the stylus to press and hold the Reset button for about two seconds. (For details on finding soft reset, see “Chapter 2, 

Bottom Edge Components .”) 

To perform a full reset 
 
Warning:  Clearing memory deletes all data and restores the Pocket PC Phone to its default settings. Programs installed at the 

factory remain, while data you have created and programs you have installed are erased. 
  

 

 

 

1. Unscrew the stylus and use the smaller point of the top-half.  

 

 

2. Press the battery switch once to turn it off, and then once more to 
turn it back on. 

 Use ActiveSync to keep a backup of your Pocket PC Phone data so that if you need to clear memory, you 
can restore the data on your Pocket PC Phone. For more information, see A ctiveSync Help. 

Battery loses power 

When the battery is low, you will see a battery icon (  - main battery low,  - main battery very low) in the status bar of the 



Page 95 

screen, and a pop-up screen will tell you to recharge the battery as soon as possible. The battery is split into two portions: main 
battery and backup battery. When the main battery portion is discharged, your Pocket PC Phone will power off.  However, the 
backup battery portion will preserve your data for 72 hrs. If the backup battery portion is discharged, you run the risk of losing the 
data on your Pocket PC Phone. 
 
You want your Pocket PC Phone battery charge to last as long as possible, especially when you are on the road. Under normal 
conditions, you can get many hours of use from a single set of batteries or from a full charge. Here are a few tips to help you get 
the most from them. 

Use external power whenever possible 
Use the AC adapter to plug your Pocket PC Phone into external power whenever possible, especially when: 
?? Establishing a remote connection. 
?? Using the front light feature of your Pocket PC Phone display. 
?? Connectin g to a PC. 
?? Letting the notification light flash for extended periods. 

Shorten auto suspend time 
While on battery power, your Pocket PC Phone automatically suspends operation if you have not touched the hardware buttons or 

used the stylus for a specified period. Maximize battery life by shortening the time. Tap  and then Settings. On the System 
tab, tap Power, and then adjust the On battery power setting. 
 

To turn off sounds you do not need 
The Pocket PC Phone produces sounds in response to a number of events, such as warnings, appointments, screen taps and 

hardware button presses. To optimize battery life, turn off any sounds you do not need. Tap    and then Settings. On the 
Personal  tab, tap Sounds & Notification and clear check boxes on the Volume and Notifications tabs. 

To turn off notification light 

Tap   and then Settings . On the Personal tab, tap Sounds & Reminders. On the Reminders tab, clear the Flash light for  
check box. 

If you forget your password 
If you forget your password, you will need to clear memory on the Pocket PC Phone. See Resetting the Pocket PC Phone and 
Clearing Memory earlier in this appendix. 

If you run out of phone memory 
Memory on your Pocket PC Phone is shared between storage memory and program memory. Storage memory is used to store the 
information you create and programs you install. Program memory is used to run programs on your Pocket PC Phone. Your 
Pocket PC Phone automatically manages the allocation between storage and program memory. However, in some situations, such 
as when memory is low, your Pocket PC Phone may not be able to automatically adjust the allocation. If you receive a message 
stating that storage or program memory is unavailable, try the following solutions. 

Finding Space in Storage Memory 
?? Move data to a MMC/SD storage card. 

?? Tap , Programs , and then File Explorer. Tap and hold the file you want to move, and tap Cut. Browse to the My 
Documents folder in the storage card folder, tap Edit and then tap Paste . Files stored in folders other than My Documents, or 
stored in folders within folders in My Documents, may not show up in the list view of some programs. When using Notes, 
Pocket Word, or Pocket Excel, you can also move files by opening the item and tapping Tools or Edit and then 
Rename/Move. 

?? Move e-mail attachments. In Inbox, tap Tools and then Options . On the Storage tab, select Store attachments on storage 
card. All attachments are moved to the storage card, and new attachments are automatically stored on the storage card. 

?? Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items on the storage card. In the 
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program, tap Tools and then Options. 
 
?? If you are copying files from your PC or another Pocket PC Phone to your Pocket PC Phone, try adjusting the slider in the 

Memory setting. Tap  and then Settings. On the System tab, tap Memory and check whether the slider can be adjusted 
manually before copying files. 

?? Delete unnecessary files. Tap , Programs and then File Explorer.  Tap and hold the file, and then tap Delete on the 

pop-up menu. To find your larger files, tap  and then Find. In the Type list, tap Larger than 64 KB , and then tap Go. 

?? In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and then Options. Tap Delete 
Files  and Clear History. 

?? Remove programs you no longer use. Tap  and then Settings . On the System tab, tap Remove Programs . Tap the 
program you want to remove and then tap Remove . 

 
?? Clear program memory as described in the following section. This will free some program memory so that it can be allocated 

to storage memory. 

Finding Space in Program Memory 
?? Stop programs you are not currently using. In most cases, programs automatically stop to free needed memory. However, in 

some situations, such as when confirmation dialog boxes are waiting for a user response, the program may not be able to 

automatically stop. To check the state of your active programs, tap  and then Settings. On the System tab, tap Memory 
and then the Running Programs  tab. Tap the program you want to view and then tap Activate . Close any open windows or 
messages and return the program to list view. If this does not work, you can stop the program manually. First, make sure that 
closing open items and returning the program to list view saves your work. Then, stop the program by tapping Stop or Stop 
All on the Running Programs  tab.  

?? Clear storage memory as described in the preceding section. This will free some storage memory so that it can be allocated to 
program me mory. 

?? Resetting your Pocket PC Phone can release the program memory.  You can do it as described in Resetting the Pocket PC 
Phone and Clearing Memory earlier in this appendix. 

Screen freezes or responds slowly 
Reset your Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix. 

Screen is blank 
If your Pocket PC Phone does not respond when you briefly press the Power button, press and hold the button for a full second. If 
that does not work: 
?? Make sure your Smart Card door cover is closed and all expansion slots are secured. 
?? Plug the AC power into your Pocket PC Phone. 
?? Reset the Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix. 

Screen is dark 
Prolonged exposure to direct sunlight may cause your Pocket PC Phone screen to temporarily darken. This is normal for LCD 
screens and is not permanent. 

Screen is hard to read 
If you are having a hard time viewing a document in Notes, try changing the size of the view. To do this, tap a zoom percentage on 
the Tools  menu. In Pocket Word and Pocket Excel, on the View menu, tap Zoom and then select a zoom percentage. In Pocket 
Internet Explorer, on the View menu, tap Text Size and then select a size. 
 
If you are having a hard time viewing Pocket Outlook data, try enlarging the display font. To do this within Calendar, Tasks, or 
Contacts, tap Tools, then Options  and then select Use large font. 

Inaccurate response to stylus taps 

Adjust the touch screen to respond more accurately to screen taps. Tap  and then Settings . On the System tab, tap Screen and 
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then Align Screen. Or press and hold Calendar button and then press Action to launch the screen tapping calibration process. 

Slow or no response 
Reset your Pocket PC Phone. See Resetting the Pocket PC Phone and Clearing Memory earlier in this appendix. 

Infrared (IR) connection problems 
If you are unable to use IR to transfer information, try the following: 
?? Transfer only one file or no more than 25 contact cards at a time. 
?? Line up the IR ports so that they are unobstructed and within close range. 
?? Make sure nothing is between the two IR ports.  
?? Adjust the room lighting. Some types of light interfere with IR connections. Try moving to a different location or turning off 

some lights. 

Phone connection problems 
If you have a problem using your phone, try the following:  
?? Make sure your wireless connection to your mobile service provider is switched on and the signal is unobstructed. (For more 

information see “Checking You Are Connected” in Chapter 4).  
?? Contact your mobile phone service provider for help. 

Internet connection problems 
The following connection problems may occur.  Additional troubleshooting information is available in Connections Help on the 
Pocket PC Phone and ActiveSync Help on the desktop PC. 
?? Check you have set up and connected to an Internet Service Provider.  
?? Make sure  your wireless connection to your mobile service provider is switched on and the signal is unobstructed (For more 

information, see “Checking You Are Connected” in Chapter 4).  
?? Verify with your Internet service provider that your user name and password are correct. 
?? Verify with your Internet service provider that the network you are trying to connect to is available, or try to connect to it 

from another PC.  

Network connection problems 
The following connection problems may occur.  Additional troubleshooting information is available in Connections Help on the 
Pocket PC Phone and ActiveSync Help on the desktop PC. 
?? Make sure your wireless connection to your mobile service provider is switched on and the signal is unobstructed (For more 

information, see “Checking You Are Connected” in Chapter 4). 

?? Verify that you have added necessary server information. Tap  and then Settings. On the Connections tab, tap Network 
Adapters. Most networks use DHCP, so you should not have to change these settings unless your network administrator 
instructs you to do so. 

 
?? If Network Connection is not listed as a connection method in the ActiveSync dialog box when starting synchronization, 

wait a few minutes and try again. Also, if synchronization does not start right away, the network is probably busy and it may 
take a minute for your Pocket PC Phone to connect to the network. 

 
?? Verify with your network administrator that your user name and password are correct. 
 
?? Verify with your network administrator that the network you are trying to connect to is available, or try to connect to it from 

another PC.  
?? You may need to change the Pocket PC Phone name if you are trying to connect to a network and cannot because another 

Pocket PC Phone with the same name is already connected. To change the Pocket PC Phone name, tap  and then 
Settings. On the System tab, tap About and then the Pocket PC Phone ID tab. 

Cable and cradle connection problems 
The following solutions may help if you encounter problems when connecting to your desktop PC. Additional troubleshooting 
information is available in Connections  Help on the Pocket PC Phone and ActiveSync Help on the PC. 
?? Ensure the Pocket PC Phone is turned on. 
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?? Ensure that you do not have any other active connections. Tap  and then Today. Tap  or  at the bottom of the 
screen and then Disconnect. 

 
?? Ensure the cable is securely plugged into the COM port on the back of your desktop PC. Use the cable that came with the 

Pocket PC Phone without any extra cables or extenders attached. 

?? Plug the other end of the cable securely into the correct port on your Pocket PC Phone. If you are using a cradle, push your 
Pocket PC Phone securely into the cradle. 
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Appendix C: Regulatory Notices 
Regulatory Agency Identification Numbers 
For regulatory identification purposes your product is assigned a model number HTC 9500. 
The following accessories have been evaluated for use with your Pocket PC Phone. Their assigned model numbers listed 
below can identify these approved accessories. To ensure continued reliable and safe operation of your Pocket PC Phone, 
use only the accessories listed below with your HTC 9500. 

 

Accessories  Model Number 

Pocket PC Phone HTC 9500 
 

Cradle HTC 9500 

 

  

External Battery Pack HTC 9500 

 

Car Charger HTC 9500 

 

Headset HTC 9500 

 

SD card HTC 9500 

 
 

Note: This product is intended for use with certified Class 2, rated 5 V dc, minimum 1A power supply unit. 

European Union Notice 
Products with CE marking comply with the R&TTE Directive (99/5/EC), the EMC Directive (89/336/EEC) and the Low 
Voltage Directive (73/23/EEC) issued by the Commission of the European Community. 

Compliance with these directives implies conformity to the following European Norms (in brackets are the equivalent 
international standards):  

 EN 60950 (IEC 60950) - Safety of Information Technology Equipment 

 ETS 300 342-1 (June 1997) - Electromagnetic compatibility and Radio spectrum Matters (ERM); 
ElectroMagnetic Compatibility (EMC) for European digital cellular telecommunications system (GSM 900MHz 
and GSM 1900MHz); Part 1: Mobile and portable radio and ancillary equipment 

 GSM11.10 

 ANSI/IEEE C.95.1-1992- specific absorption rate in mobile phone emission condition for body health  

 FCC part 15 and part 24 

 prENV50166-2, 1995 for SAR  
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Important Safety Information 
Retain and follow all product safety and operating instructions. Observe all warnings on the product and in the operating 
instructions. 
To reduce the risk of bodily injury, electric shock, fire, and damage to the equipment observe the following 
precautions. 

General Precautions 
Heed service markings: Except as explained elsewhere in the Operating or Service documentation, do not service any 
product yourself. An authorized service technician or provider should do service needed on components inside these 
compartments. 
 

Damage requiring service: Unplug the product fro m the electrical outlet and refer servicing to an authorized service 
technician or provider under the following conditions: 
 

?? Liquid has been spilled or an object has fallen into the product. 
?? The product has been exposed to rain or water. 

?? The product has been dropped or damaged. 
?? There are noticeable signs of overheating. 
?? The product does not operate normally when you follow the operating instructions. 

 
Avoid hot areas: The product should be placed away from heat sources such as radiators, heat registers, stoves, or other 
products (including amplifiers) that produce heat. 

Avoid wet areas: Never use the product in a wet location. 
Avoid pushing objects into product: Never push objects of any kind into cabinet slots or other openings in the product. Slots 
and openings are provided for ventilation. These openings must not be blocked or covered. 
Mounting Accessories: Do not use the product on an unstable table, cart, stand, tripod or bracket. Any mounting of the 
product should follow the manufacturer’s instructions, and should use a mounting accessory recommended by the 
manufacturer. 

Avoid unstable mounting: Do not place the product with an unstable base.  
Use product with approved equipment: This product should be used only with personal computers and options identified as 
suitable for use with your equipment. 
Adjust the volume: Turn down the volume before using headphones or other audio Pocket PC Phones. 
Cleaning:  Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a 
damp cloth for cleaning, but NEVER use water to clean a LCD screen. 

Safety Precautions for Power Supply Unit 
Use the correct external power source: A product should be operated only from the type of power source indicated on the 
electrical ratings label. If you are not sure of the type of power source required, consult your authorized service provider or 
local power company. For a product that operates from battery power or other sources, refer to the operating instructions that 
are included with the product. 

Handle battery packs carefully: This product contains a Lithium Polymer battery. There is a risk of fire and burns if the 
battery pack is handled improperly. Do not attempt to open or service the battery pack. Do not disassemble, crush, puncture, 
short external contacts or circuits, dispose of in fire or water, or expose a battery pack to temperatures higher than 60?C 
(140?F). 

 
WARNING:  Danger of explosion if battery is incorrectly 
replaced. Replace only with specified batteries. Dispose of used 
batteries according to the local regulations or Reference Guide 
supplied with your product. 
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Appendix D: Hardware Specifications 
Feature Component 
PDA module: Processor 
                       Memory 

Intel SA-1110 CPU 
SDRAM 32MB/64MB; Flash ROM: 32MB  

GSM/GPRS module 900/1900 MHz 
LCD module 3.5” 240x320 pixels, 4096 colors reflection TFT. 
Buttons Four buttons (2 GSM and 2 Windows CE AP buttons - programmable); 

power and backlight control; navigation pad for scroll up, down, left, right 
and action; volume adjustment button.   

Stylus 95mm, maximum diameter 5mm 

Notification One LED or Vibration motor for GSM and PDA for event standby alarm; 
charging. 

Audio Built in Microphone, speaker and buzzer; one earphone/microphone jack 
with stereo sound; MP3 stereo 

Interface Plug in Smart Card; feature connector (RS-232, USB and DC power); 
infrared IrDA SIR. 

Power Rechargeable battery Talk: 4 –5 hours; standby: 150 – 170 hours; PDA: 
15-17 hours, Li-Polymer; 3.7V 1500 mAh; AC adapter 90-240VAC, 5V/2A 
10W; built-in charger.  

Accessories  AC adapter 100–240v 5A= 1V; USB cradle; earphone plug; service kit; 
protective pouch.  
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Appendix E: Icons 
Phone 

 
Phone off or out of network service - tap to turn on the phone. 

 Phone on or in network service - tap to turn off the phone. 

 
Call Missed - tap to view the call(s) you missed, or tap and then tap Close to erase the icon. 

 
E-mail or SMS notification - tap to view the SMS or E-mail not read, or tap Close to erase the icon. 

 
Synchronization proceeding - the icon will disappear when synchronization is finished. 

 
Send button - press to make a phone call. 

 
End button - press to end a call. 

 
Talk - tap to have a phone call in phone dialer. 

 
Clear - tap to erase the number you input in phone dialer.  

 
End - tap to end a call in phone dialer. 

 
Erase - tap to erase the numbers you input one by one. Or tap and hold the icon to erase the whole number you input in 

phone dialer. 

 
Notes - tap during a call to make a note for the particular call in phone dialer.  

 
Speed Dial - tap to view a speed dial list, and speed dial a number in phone dialer. 

 
The order in the speed dial list - tap to speed dial. 

 
Call Log - tap to view the call you made/received in phone dialer. 

 
Incoming call - notifies you it is an incoming call. 

 
Outgoing call - notifies you it is an outgoing call. 

 
Missed call - notifies you it is a call you missed. 
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Pocket PC 

 
Start menu - tap to pull down the start menu. 

 
System volume - tap to adjust the volume for both the phone and Pocket PC.  

 
Power low - notifies you the battery is in the power low status. 

 
Power very low - notifies you the battery is in the power very low status - recharge to avoid lost data. 

 
Connection is active - the icon will disappear when the connection ends. 

 
Synchronization proceeding - the icon will disappear when synchronization is finished. 

 
Instant message notification - tap it to read the content of the instant message. 

 
E-mail or SMS notification - tap to view unread SMS or E-mail, or tap and then tap Close to erase the icon. 

 
Establishing the connection - the icon will disappear when the connection is established. 

 
Icon room - if more notification icons need to be displayed than is room to display them, tap the icon to view all 

notification icons.  

 
ActiveSync - synchronizes information between your Pocket PC Phone and PC. 

 
Calendar - keeps track of your appointments and creates meeting requests. 

 
Contacts - keeps track of your friends and colleagues. 

 
Inbox - sends and receives e-mail/SMS messages. 

 
Pocket Internet Explorer - browse Web and WAP sites, and download new programs and files from the Internet. 

 
Notes - create handwritten or typed notes, drawings and recordings. 

   
MS Reader - read e-Books on your Pocket PC Phone. 

 
Image Viewer - view JPG and GIF formatted pictures on your Pocket PC Phone. 

 
Tasks - keep track of your tasks. 

 
Pocket Excel - create new workbooks or view and edit saved Excel workbooks. 

 
Pocket Word - create new documents or view and edit saved MS Word documents.  

 
MSN Messenger- send and receive instant messages with your MSN Messenger contacts. 

 
Phone - make and receive calls, swap between calls and set up conference calling.  

 
SD Backup - back up your Pocket PC Phone files to a SD card. 

 
Phone Book - load contents of your Smart Card to your Pocket PC Phone and transfer to Contacts. 
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Windows Media Player - enable the multimedia function on your Pocket PC Phone. 

 

Buttons - assign application programs to hardware buttons. 

 
Input - set up the input portion of your Pocket PC Phone. 

 
Menu - customize what appears on the  menu, and enable a pop-up menu from the New button. 

 
Owner Information - enter your personal contact information. 

 
Password - limit access to your Pocket PC Phone. 

 
Phone - set up the phone function of your wireless feature. 

 

Sound and notification - set the notification type, event and volume. 

 

Today - customize the look and the information that is displayed on the Today screen. 

 
Backlight - customize the backlight on/off and brightness for power saving purposes. 

 

Clock - change the time or set alarms. 

 

Microphone AGC - enable/disable the microphone Automatic Gain Control (AGC). 

 

Power - maximize battery life. 

 

Regional settings - customize relative formats for the region you use. 

 
Remove programs - remove some application programs not used frequently to save limited memory. 

 

Screen - recalibrate the screen tapping and enable/disable the ClearType feature. 
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Statement according FCC part 15.19 
 

    
 
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation. 
 
Statement according FCC part 15.21 
 
Modifications not expressly approved by Future Internet Ltd. Co. could 
void the user's authority to operate the equipment. 
 
Statement according FCC part 15.105 
 
NOTE: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures: 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and receiver. 
-- Connect the equipment into an outlet on a circuit different from that to which the receiver  is connected.  
-- Consult the dealer or an experienced radio/TV technician for help.  
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RF eposure  

 
Tests for SAR are conducted using standard operating positions specified by the FCC with the phone transmitting at its 
highest certified power level in all tested frequency bands. Although the SAR is determined at the highest certified power 
level, the actual SAR level of the phone while operation can be well below the maximum value. This is because the phone is 
designed to operate at multiple power levels so as to use only the power required to reach the network. In general, the 
closer you are to a wireless base station antenna, the lower the power output.  
Before a phone model is available for sale to the public, it must be tested and certified to the FCC that it does not exceed the 
limit established by the government -adopted requirement for safe exposure. The tests are performed in positions and 
locations (e.g., at the ear and worn on the body) as required by the FCC for each model. (Body-worn measurements may 
differ among phone models, depending upon available accessories and FCC requirements). While there may be differences 
between the SAR levels of various phones and at various positions, they all meet the government requirement for safe 
exposure.  
For body worn operation, to maintain compliance with FCC RF exposure guidelines , use only High Tech Computer Corp. approved 
accessories. When carrying the phone while it is on, use the specific High Tech Computer Corp. -supplied or approved carrying case, 
holster, or other body-worn accessory. 
Use of non-High Tech Computer Corp. -approved accessories may violate FCC RF exposure guidelines and should be avoided. 
 
Health and Safety Information 
Exposure to Radio Frequency (RF) Signals 
Your wireless phone is a radio transmitter and receiver. It is designed and manufactured not to exceed the emission limits 
for exposure to radio frequency (RF) energy set by the Federal Communications Commission of the U.S. Government. 
These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the general population. 
The guidelines are based on the safety standards previously set by both U.S. and international standards bodies:  
 
• American National Standards Institute (ANSI) IEEE. C95.1-1992 
• National Council on Radiation Protection and Measurement (NCRP). Report 86. 1986 
• International Commission on Non-Ionizing Radiation Protection (ICNIRP) 1996 
• Ministry of Health (Canada), Safety Code 6. The standards include a substantial safety margin designed to assure the 
safety of all persons, regardless of age and health. 
 
The exposure standard for wireless mobile phones employs a unit of measurement known as the Specific Absorption Rate, 
or SAR. The SAR limit set by the FCC is 1.6W/kg *. 
 
*In the U.S. and Canada, the SAR limit for mobile phones used by the public is 1.6 watts/kg (W/kg) averaged over one gram of tissue. The standard incorporates a substantial margin 
of safety to give additional protection for the public and to account for any variations in. 


